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1.1 GETTING STARTED

The Synthesis Tool was developed using Microsoft® Excel 2000. While the module will
operate with older versions of Excel, it functions best with Excel 2000 or later. Some of the
Excel basics are outlined in the steps below. Before you use the Synthesis Tool, make sure
your computer meets the system requirements. In order to install and run the Synthesis
Tool, you must have:

e IBM-PC compatible computer with the Windows 95 operating system or later;

e Microsoft® Excel 1997 or later, with calculation set to automatic and macros
enabled;

e Hard drive with at least 20MB free; and
e Monitor display setting of 800 x 600 or greater.

Microsoft Excel Settings

Excel 2003 and Earlier: For the SIT modules to function properly, Excel must be set to
automatic calculation. To check this setting, launch Microsoft Excel before opening the
Synthesis module. Go to the Tools menu and select “Options...” Click on the “Calculations”
tab and make sure that the radio button next to “"Automatic” is selected, and then click on
“OK" to close the window. The security settings (discussed next) can also be adjusted at
this time.

Excel 2007 and Later: For the SIT modules to function properly, Excel must be set to
automatic calculation. Go to the Formulas ribbon and select “Calculation Options.” Make
sure that the box next to the “"Automatic” option is checked from the pop-up menu.

Microsoft Excel Security

Excel 2003 and Earlier: Because the SIT employs macros, you must have Excel security
set to medium (recommended) or low (not recommended). To change this setting, launch
Microsoft Excel before opening the Synthesis module. Once in Excel, go to the Tools menu,
click on the Macro sub-menu, and then select “Security” (see Figure 1). The Security pop-
up box will appear. Click on the “Security Level” tab and select medium. When set to high,
macros are automatically disabled; when set to medium, Excel will give you the choice to
enable macros; when set to low, macros are always enabled.

When Excel security is set to medium, users are asked upon opening the module whether to
enable macros. Macros must be enabled in order for the Synthesis module to work. Once
they are enabled, the module will open to the control worksheet. A message box will
appear welcoming the user to the module. Clicking on the “x” in the upper-right-hand
corner of the message box will close it.

Excel 2007 and Later: If Excel’s security settings are set at the default level a Security
Warning appears above the formula box in Excel when the Synthesis module is initially
opened. The Security Warning lets the user know that some active content from the
spreadsheet has been disabled, meaning that Excel has prevented the macros in the
spreadsheet from functioning. Because SIT needs macros in order to function properly, the
user must click the “"Options” button in the security message and then select, “Enable this
content” in the pop-up box. Enabling the macro content for the SIT in this way only enables
macros temporarily in Excel but does not change the macro security settings. Once macros
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are enabled, a message box will appear welcoming the user to module. Click on the “x” in
the upper right-hand corner to close the message box.

If the Security Warning does not appear when the module is first opened, it may be
necessary to change the security settings for macros. To change the setting, first exit out
of the Synthesis module and re-launch Microsoft Excel before opening the Synthesis
module. Next, click on the Microsoft Excel icon in the top left of the screen. Scroll to the
bottom of the menu and select the “Excel Options” button to the right of the main menu.
When the Excel Options box appears, select “"Trust Center” in left-hand menu of the box.
Next, click the grey “"Trust Center Settings” button. When the Trust Center options box
appears, click "Macro Settings” in the left-hand menu and select “"Disable all macros with
notification.” Once the security level has been adjusted, open the Synthesis module and
enable macros in the manner described in the preceding paragraph.

Viewing and Printing Data and Results

The Synthesis Tool contains some features to allow users to adjust the screen view and the
appearance of the worksheets when they are printed. Once the tool has been opened, you
can adjust the zoom by going to the Module Options Menu, and either typing in a zoom
percentage or selecting one from the drop-down menu. In addition, data may not all
appear on a single screen within each worksheet; if not, you may need to scroll up or down
to view additional information.

You may also adjust the print margins of the worksheets to ensure that desired portions of
the Synthesis Tool are printed. To do so, go to the File menu, and then select “Print
Preview.” Click on “Page Break Preview” and drag the blue lines to the desired positions
(see Figure 2). To print this view, go to the File menu, and click “Print.” To return to the
normal view, go to the File menu, click “Print Preview,” and then click *Normal View.”
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1.2 SYNTHESIS TooL OVERVIEW

The Synthesis Tool was designed as a companion to EPA’s State Inventory Tool (SIT), which
estimates state-level emissions for 1990-2022. Users who have completed the historical
emission estimation process using the SIT modules can import the historical emissions into
the Synthesis Tool to compile the time series for all modules from 1990 through 2025.
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1.2.1 Data Requirements

Before using this module, the user should conduct greenhouse gas inventories for all
applicable sources using the individual sector modules. The individual sector modules
include the following: CO2 from Fossil Fuel Combustion, Electricity Consumption, Stationary
Combustion, Mobile Combustion, Coal Mining, Natural Gas and Oil Systems, Industrial
Processes, Agriculture, Land Use, Land-Use Change and Forestry, Municipal Solid Waste,
and Wastewater.

After completing each sector inventory, the user should export the data using the “Export
Data” button provided in the final step of each sector module. The modules will then create
an output file using a default file name. Please do not change the file names or alter the
output files in any way. Once the output files have been generated, the Synthesis module
can then be used.

1.2.2 Tool Layout

Because there are multiple steps to complete within the Synthesis Tool, it is important to
understand the Tool’s overall design. The layout of the Synthesis Tool is presented in Figure
3.

Figure 3. Flow of Information in the Synthesis Tool
Control Worksheet Module Worksheets (for Reviewing Data)

1. Choose a State
2. Locate Output File, Import, and Review Data for Each Module:

CQ. from Fossil Fuel Combustion ™ 7~ CO, from Fossil Fuel Combustion
Indirect CQy from Electricity Consumption Indirect CQy from Electricity Consumption
Stationary Combustion Stationary Combustion
habile Combustion habile Combustion
Coal Mining _< Coal Mining
Matural Gas and Qil Systems > Matural Gas and Qil Systems
Industrial Processes Industrial Processes
Agriculture Agriculture
Land-Use Change and Forestry Farest Management and Land-Use Change
funicipal Solid Waste funicipal Solid Waste
Wastewater _ \_Wastewater
3. Select Units and View Summary Worksheets €———> Summary Data

] By Sector: presented in table and graphical formats
| By Gas: presented in table and graphical formats
] By Intensity: presented in table and graphical formats

1.3 METHODOLOGY

This section provides a guide to using the Synthesis Tool to import emission estimates from
completed modules of the SIT. The following three steps describe how to import and view
the estimates provided by the eleven SIT modules: (1) select a state on the control
worksheet; (2) locate output file, import, and review data for each module; (3) select units
and view summary information.
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Step (1): Select a State on the Control Worksheet

To begin, select the state you are interested in evaluating. By selecting a state, the rest of
the tool will automatically reset to reflect the appropriate state default data and
assumptions for use in subsequent steps of the tool.

Step (2): Locate Output File, Import, and Review Data for Each Module

This step involves importing the output files containing emission estimates from the
individual modules. While the CO2 from Fossil Fuel Combustion (CO2FFC) module will be
used as an example of how to import and review data, the importing process is identical
across for all eleven SIT modules.

On the control worksheet, select the “"Get CO2 from Fossil Fuel Combustion Data” button.
Once this button is selected, you will be prompted to locate the summary file exported from
the CO2FFC module (called "CO2FFC_Summary”) as shown in Figure 4.

Figure 4. Example of Importing Data in the Synthesis Tool
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3. View the Summary Sheets:

S0 to Summary by’
Sector

So to Summary by
Intensity

S0 to Summary by
Gas

If the file is imported successfully, the current date and time will appear in the column titled
“Summary File Imported on”. This timestamp is useful to have if you are completing an
inventory on an annual basis and would like to know the last time data was imported into
the Synthesis Tool.

To review the data that was imported for a given module, click on the gray navigational
arrow to the right of the module you would like to review. The summary data worksheet by
sector for the CO:2 from Fossil Fuel Combustion is shown in Figure 5. Modules with
“Additional Emissions Sources” tabs will automatically integrate these emissions into the
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synthesis summary. In each sector summary worksheet, users have the option to enter
total emissions data by gas (in MMTCO:zE) from ‘Additional Emissions Source(s)’ if you have
emission sources that are not already covered by the sector module or its additional
emissions sources tab. Any additional emissions are pulled into the Summary by Sector and
Summary by Gas worksheets. To return to the control worksheet, click on the gray
navigational arrow.

Figure 5. Example of CO2FFC Summary Worksheet

Summary of COZ2 Emissions from Fossil Fuel <Mmmcgm| F
L . Shest Return to
Combustion in Florida (MMTCOZ2E) Control

This tab summarizes emizsions from fossil fuel combustion in million metric tons carbon dicedde equivalent (MMTCOLE) using emiszions results TR T IS T T T

Ermissians from an additional emissions source can be entered (in MMTCOLE) in the “Additional Ermissions Source” row if your state has emission sources that are not slready included
in the sector module. Any addifional emissiens are pulled into the Summary by Sector and Summary by Gas workshests.

Emissions [MMTCO: Eq.]) 1990 1991 1992 1993 1994 1995 1996 1997 1998 1999 2000
I Fesidential | 154 158 175 167 157 143 166 137 145 142 152
Coal 0.00 0.00 0.0 0.0 0.0 0.0 0.0 - L] 0.0 0.00
Fetraleum i) 023 0.30 0.86 or4 0ET 0E3 0E: QEE 0ED 0E3
Fatural Gas 074 075 n0.a4 0.1 023 o2 0.96 L] 0nra 076 023
Clthar - - - - - - - - - - -
Commerzial E.26 5.98 5.7 478 436 434 417 364 356 264 4.8
Coal n.om 0.00 003 003 0.04 0.0 0.0 - 0.01 0.01 n.nz
Fetroleum 417 370 5 238 143 208 170 153 145 182 193
Matural Gas 2.08 2.28 243 239 2.38 2.28 247 2.05 210 2.01 28
Oither - - - - - - - - - - -
Industrial 1.9 .29 12.30 14.15 14.95 16.19 16.04 a1 1823 18.339 14.47
Coal 23 265 an 303 302 310 247 ALY 247 276 2.98
Fetraleum 423 36T 467 5.31 4.0 5.45 5.33 4433 6.56 6.26 538
Matural Gas 187 4497 513 5.81 .03 T2 TE3 £.93 BTG T E12
Oither - - - - - - - - - - -
Transportation 2149 7716 74.91 TETI 5426 3648 7.4 3060 3203 34.78 100.35
Cioal - - - - - - - - - - -
Petraleum 21.33 TE.95 T9.EG TOAT 93.94 8605 av.0e 027 180 94.39 100.51
Matural Gas 0ie 0.z0 0.26 026 0.3z 043 0.35 03: nz: 0.40 0.44
Oither - - - - - - - - - - -
Electric Litilities 86.13 9124 2417 43.35 A5.08 a7.14 10188 105.85 1634 1268 114.35
Coal 65.94 A7.65 a7.08 A7.E6 5850 BOED BE.25 EEES BE.23 E3.13 E7.03
Petraleum 191 2279 21 2562 26.21 1671 1753 2051 3210 29.33 27.95
Matural Gas 014 020 10 00 i 8.8 12.04 1263 1747 2014 13.97
Oither - - - - - - - -
International Bunker Fuels - Enter -OPtIOnaI ooz 003 noz nog noz 0oz
Fatroleum - Additional 002 0.03 0.02 004 002 0.02
TOTAL 18643 181 Emissions Source 20566 21119 216.59 228.70 227.90 23672 2|
Coal 8877 B3T3 B3.23 B4.80 BT E5.96 T0.03

Petraleum W9ET or.ae 09,97 24 1ET4 1145 246 ez 1HED .zr 12E4E
Flatural Gas 19.00 1953 19.35 2194 3048 2950 2878 2783 06T a0.22
Oither - - - - - - - - - - -

Additional Emissions Source

Step (3): View Summary Information

Once the data from all of the modules has been imported, you can view estimates in
MMTCO:E on the final summary worksheet. A summary of the modules by sector, gas, or
intensity (per capita and by gross state product) is provided within the Synthesis module.
An example of the sector summary worksheet is shown in Figure 6. In addition, the results
are displayed in graphical format at the bottom of the summary worksheets. Mobile module
CO2 emissions and emissions from electricity consumption are not included in the final
summary worksheet as they are included in the top-down emissions reported under CO:2
from Fossil Fuel Combustion.
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Fii ure 6. Exami le of Summar‘ Worksheet b‘ Sector
S state Inventory Tool - Synthesis Madule

(0] Ele  Edit  Modudle Options
Summary of GHG Emissions by Sector in Colorado fetam 1o Cantrol | | G0 1o Summary by Go to Surany by
(MMTCO ZE) Sheet Bas Intensity
Emissions (MMTCOZE) 1990 1991 1992 1993 1994 1995 1996 1997 1993 1999 2000
Energy 590,91 6B8.27 696,63 al0.60 612,73 614,75 661,87 682.00 683.87 671,60 696,36
£, from Fossil Fuel Combustion BE0.46 586,683 594,04 609,14 611,29 613.32 660,34 68043 682,39 670.03 693.81
Stationary Combustion 144 149 146 144 143 163 166 148 147 166
#habile Combustion - s - - - - - -
Caal Mhining - - ummary - - - - - -
Natural Bas ard il Systens - - by Sector - - - - - -
Industrial Processes .66 B T T 1z2.21 1316 1771 18.10 17.90 19.06
Agriculture % 46,94 48.03 4749 4712 46,27 46.66 46,07 44.13
Enteric Fermentation B 19.88 20,80 20,93 2062 19.48 19.64 19.31 18.96
Mharure Management 370 387 378 367 3.60 3.84 3.76 3.97
Rice Cultivation 13z 167 141 13z 115 125 115 1.09
Agricultural Soil Management 2102 2176 21.39 2149 2092 20.80 20.83 20.09
Burning of Agrmultum\ Crop Waste n.oz n.oz n.oz 0.0z 0.0z 0.0z 0.02 0.02
LULUCF
Waste 133 130 139 141 144 147 149 1559
hunicipal Solid Waste
Wastewater 126 lze 131 133 136 139 141 144 147 149 155
Gross Emissions 643 .43 641.32 650.70 667.60 672.90 675.85 723.57 746.41 748.99 735.97 760.10
Sinks = = = = = = = = = = =
Net Emizzionz §43.43 641.32 650.70 667.60 §72.90 §75.85 723.57 746.41 743.99 735.97 760.10
= Emissions from Electricity Consumption are not included in totals in order to avoid double courting with Fossil Fuel Combustion estimates,

1.4 CONCLUSION

Once the results of all eleven modules are imported into the Synthesis Tool, you will have a
complete inventory for your state. These results may be used to create an inventory
document, if you so desire. In addition, you may use these historical estimates as the basis
for emission projections in EPA’s Projection Tool. For instructions on using the Projection
Tool, please consult the Projection Tool User’s Guide.
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